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Introduction 
 
This Windows Driver Manual provides information on installation, detailed specifications, and 
usage of the printer’s Windows Driver according to PC operating system (OS). 
 
 
It is advisable to read the contents of this manual carefully before using the Windows Driver 
for the first time. 
 
 
 

Symbols Information  

Note Important information and useful tips. 
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1. Operating System (OS) Environment                                                
 

The following operating systems are supported for usage. 

 
Microsoft®  Windows XP SP3 (32bit)  
Microsoft®  Windows XP SP1 or later (64bit)  
Microsoft Windows Server 2003 SP1 or later (32bit/64bit) 
Microsoft Windows VISTA (32bit/64bit) 
Microsoft Windows Server 2008 (32bit/64bit) 
Microsoft Windows Server 2008R2 (64bit) 
Microsoft Windows 7 (32bit/64bit) 
Microsoft Windows 8 (32bit/64bit) 
Microsoft Windows Server 2012 (64bit) 
Microsoft Windows 10 (32bit/64bit) 
 

Note 

- Serial printer port do not work on Windows 10 version 1511 (OS 
Build 105860.104) specific. We recommend you to install the latest 
Windows 10 update through Windows Update before installing 
Windows Driver. 
- You can download and install the Windows Update in the Update & 
security tab of the Settings menu. 

(  > Settings > Update & security > Windows Update). 
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2. Supported Printers                                   
 

This manual provides information for the following printer drivers. 
 

Models Resolution 

SPP-R200II 
SPP-R200III 
SPP-R210 
SPP-R220 
SPP-R300 
SPP-R310 
SPP-R400 
SPP-R410 

203 DPI 

 
 
 
 
 

3. Windows Driver Preparation                                                
 
The Windows Driver is included in the enclosed CD, and the latest file version can be 
downloaded from BIXOLON website. (www.bixolon.com) 

http://www.bixolon.com/
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4. Windows Driver Installation                                                
 

4-1 Installation on Windows XP / Server 2003 
 
1) Double-click “Software_[Model name]_Windows_Driver_Vx.x.x.exe”. 
 
2) The Network Auto Installation function allows you to install drivers for the same network 
printer. Before using the function, the IP address of the printer must be set, so download the 
Net Configuration Tool from our website and set the IP address first. 
 

Note 

- In case of the printer’s IP address is invalid or the printer is 
communicating with another application, etc., the printer cannot be 
searched through the Network Auto Installation function. 

 
3) Follow the instructions on the screen to complete the installation process. 
 
 
4-2 Installation on Windows Vista / Server 2008 / 7 / 8 / Server 2012 / 10 
 
1) Double-click “Software_[Model name]_Windows_Driver_Vx.x.x.exe”. 

 

2) The Network Auto Installation function allows you to install drivers for the same network 
printer. Before using the function, the IP address of the printer must be set, so download the 
Net Configuration Tool from our website and set the IP address first. 
 

Note 

- Administrator privilege may be required to run the installation file. 
- In case of the printer’s IP address is invalid or the printer is 
communicating with another application, etc., the printer cannot be 
searched through the Network Auto Installation function. 

 
3) Follow the instructions on the screen to complete the installation process. 
 
4-3 Uninstallation 
 
1) Open "Add or Remove Programs" or "Remove Programs" in the Control Panel. 

* XP or Server 2003: Control Panel – Add or Remove Programs 
* Vista or higher OS: Control Panel – Remove Programs 
 

2) Double-click "BIXOLON [Model name] Windows Driver" to uninstall the installed windows  

drivers. 
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5. Windows Driver Settings                                                
 
The following functions can be configured after installing the Windows driver. 
 
5-1 Paper 
 

  
 

1) Open the Printer Properties window and then click Printing Preferences in the General  
tab. 

 

Note 

Please refer to below paths of Printer Properties window. 
*Windows XP / Server 2003 
(Control Panel) – (Printers and Faxes) – (Right-click the icon of the printer) 
– (Click Properties) 
*Windows Vista 
(Control Panel) – (Hardware and Sound) – (Printers) – (Right-click the icon 
of the printer) – (Click Properties) 
*Server 2008 / 7 / 8 / Server 2012 / 10 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 

2) Click the Layout tab. 
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5-1-1 Paper Size 
 
Paper size of the following sizes can be selected.  
 

Models Paper sizes can be selected 

SPP-R200II 
SPP-R200III 
SPP-R210 
SPP-R220 

58  297 mm 58  3276 mm A4 210  297 mm 
 

SPP-R300 
SPP-R310 

80  297 mm 80  3276 mm A4 210  297 mm 
 

SPP-R400 
SPP-R410 

112  297 mm 112  3276 mm A4 210  297 mm 
 

 
If a custom paper size is required, click “…” to add or update a custom paper size.  

 
 

Click Save after specifying the paper width/length and a paper name. If the specified paper 
name already exists on the system, you can update the paper width/length. 
 
Paper Width  : 25.4 mm (Min) ~ 210.0 mm (Max) 
Paper Length : 25.4 mm (Min) ~ 3276.0 mm (Max) 

 

 

 

You can choose the new paper size on the Paper Size combo-box after adding a paper size. 
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Delete button : Deletes the paper size selected in the list. 

Save button : Adds a new paper size or update the paper size selected in the list if the 

paper name already exists on the system. 

 
 

5-1-2 Paper Type 
 
You can choose Receipt or Ticket as paper types.  
 
Receipt : Receipt allows flexible paper length according to the data length. 
Ticket : Ticket print in fixed length even the print data is short. 
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5-1-3 Copies 
 
Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set this 
value bigger than 1 to set the number of copies to print. The value should be within the range 
of 1 to 255. 

 
5-1-4 Orientation 
 
Printing orientation can be set to Portrait (which is the default) or Landscape. It is not possible 
to use printer fonts (device fonts) and barcode fonts in landscape. 
 
Portrait : Printing in the vertical direction. 
Landscape : Printing in the horizontal direction. 

 
5-1-5 Paper Reduction 
 
Reduction function reduces the size of the print image to save print paper. If this function is 
enabled and print-job data includes text data created by using a printer font (device font), 
printer fonts are converted to Windows fonts (True Type fonts) to make them smaller. The 
barcode size also can be reduced by selecting “Enable reducing barcode”. 
 

Note 
- 32bit applications running on 64bit Windows cannot work for this feature. 
- It can affect barcode recognition, if the barcode size is reduced. 
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5-2 Document Settings 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the General 

 tab. 

 

Note 

Please refer to below paths of Printer Properties window. 
*Windows XP / Server 2003 
(Control Panel) – (Printers and Faxes) – (Right-click the icon of the printer) 
– (Click Properties) 
*Windows Vista 
(Control Panel) – (Hardware and Sound) – (Printers) – (Right-click the icon 
of the printer) – (Click Properties) 
*Server 2008 / 7 / 8 / Server 2012 / 10 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 

2) Click the Document Settings tab. 
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5-2-1 Send Command 
 
The Windows driver serves to receive the content for print from an application and send it to 
the printer. The “Send Commands” function allows for the addition of desired commands at 
the start or end of the print content. 
 
Start Doc : Addition of command at the beginning of the document. 
Start Page : Addition of command at the beginning of the page. 
End Page : Addition of command at the end of the page. 
End Doc : Addition of command at the end of the document. 
 

Note 
For more information about the hexadecimals, refer to the Commands 
Manual. 

 
5-2-2 Paper Feed 
 
Enter a number between 0 and 99 for adding line feed commands (0x0A) or form feed 
commands (0x0C) at the end of printing. 
 
5-2-3 Tear-Off Position 
 
When this option is ticked, paper moves to tear off position (manual cutter position) after 
printing each page in a document. It probably needs to de-select this option if printing labels. 
 
5-2-4 Buzzer Sound 

 

Tick “Buzzer sound before printing” or “Buzzer sound after printing” to generate the printer 
buzzer sound at the start time or the end time of printing. 
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5-3 NV Image 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the General  

tab. 

 

Note 

Please refer to below paths of Printer Properties window. 
*Windows XP / Server 2003 
(Control Panel) – (Printers and Faxes) – (Right-click the icon of the printer) 
– (Click Properties) 
*Windows Vista 
(Control Panel) – (Hardware and Sound) – (Printers) – (Right-click the icon 
of the printer) – (Click Properties) 
*Server 2008 / 7 / 8 / Server 2012 / 10 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 

2) Click the NV Image tab. 
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The position to print NV image stored in the printer can be set at the beginning and/or end of 
the document and beginning and end of each page.  
 

Note 

There are two commands for NV Image printing. Take care of selecting one 
of the two commands because NV images cannot be printed depending on 
the selected command. 

NV bit image : FS p 
NV graphics : GS ( L 

 

 

Start Doc : Insert NV image at the top of the document. 
Start Page : Insert NV image at the top of the page. 
End Page : Insert NV image at the end of the page. 
End Doc : Insert NV image at the end of the document. 
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5-4 Graphic Settings 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the General  

tab. 

 

Note 

Please refer to below paths of Printer Properties window. 
*Windows XP / Server 2003 
(Control Panel) – (Printers and Faxes) – (Right-click the icon of the printer) 
– (Click Properties) 
*Windows Vista 
(Control Panel) – (Hardware and Sound) – (Printers) – (Right-click the icon 
of the printer) – (Click Properties) 
*Server 2008 / 7 / 8 / Server 2012 / 10 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 

2) Click the Grapchic Settings tab. 
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5-4-1 Graphic Printing 
 
Depending on graphic printing option, printer driver sends raw image data or compressed 
image data using RLE (Run-length encoding) to the printer. Select “Direct Print - 
compressed” if you want to print faster. 
 
 
5-4-2 Dithering 
 
This printer model is a black and white printing device including dithering function and 
brightness level adjustment function to produce a sharper or softer image. The following 
dithering algorithms can be selected. 
 
None 4x4 Matrix 
Error Diffusion 8x8 Matrix 
Ordered Dither  
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5-5 Utility 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the General  

tab. 

 

Note 

Please refer to below paths of Printer Properties window. 
*Windows XP / Server 2003 
(Control Panel) – (Printers and Faxes) – (Right-click the icon of the printer) 
– (Click Properties) 
*Windows Vista 
(Control Panel) – (Hardware and Sound) – (Printers) – (Right-click the icon 
of the printer) – (Click Properties) 
*Server 2008 / 7 / 8 / Server 2012 / 10 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 

2) Click the Utility tab. 
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5-5-1 Print Preview 
 
This application with a preview of a print-job runs, and windows driver does not directly send 
print-job data to the printer when enabled by clicking “Enable Print Preview”. Print-job data 
can only be sent to the printer in the application.  
 

Note 
The actual output of preview image processed by the application might 

look a little different. 

 
1) Tick Enable Print Preview to make Windows Driver ready for running the application. 
 

 

 

2) When print-job data are created via Windows Driver, the application runs, and then loads 
the data to draw the expected output on screen.   
 

3) Click Print if you want to print, or click Close to exit the application.  
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6. Windows Driver Specification                                                
 

6-1 Printer Fonts 

• This Windows driver supports various printer fonts (device fonts) in the following table.  

Printing using these fonts is faster than using Windows fonts provided by the operating  
system. 

 
 

Printer Font Name Size (Dot) 
Size (Point) 

203 dpi 

FontA1x1 FontA1x1[Ext.] FontA1x1[255] 12x24 8.5 

FontA1x2 FontA1x2[Ext.] FontA1x2[255] 12x48 17 

FontA2x1 FontA2x1[Ext.] FontA2x1[255] 24x24 8.5 

FontA2x2 FontA2x2[Ext.] FontA2x2[255] 24x48 17 

FontA2x4 FontA2x4[Ext.] FontA2x4[255] 24x96 34 

FontA4x2 FontA4x2[Ext.] FontA4x2[255] 48x48 17 

FontA4x4 FontA4x4[Ext.] FontA4x4[255] 48x96 34 

FontA4x8 FontA4x8[Ext.] FontA4x8[255] 48x192 68 

FontA8x4 FontA8x4[Ext.] FontA8x4[255] 96x96 34 

FontA8x8 FontA8x8[Ext.] FontA8x8[255] 96x192 68 

FontB1x1 FontB1x1[Ext.] FontB1x1[255] 9x17 6 

FontB1x2 FontB1x2[Ext.] FontB1x2[255] 9x34 12 

FontB2x1 FontB2x1[Ext.] FontB2x1[255] 18x17 6 

FontB2x2 FontB2x2[Ext.] FontB2x2[255] 18x34 12 

FontB2x4 FontB2x4[Ext.] FontB2x4[255] 18x68 24 

FontB4x2 FontB4x2[Ext.] FontB4x2[255] 36x34 12 

FontB4x4 FontB4x4[Ext.] FontB4x4[255] 36x68 24 

FontB4x8 FontB4x8[Ext.] FontB4x8[255] 36x136 48.5 

FontB8x4 FontB8x4[Ext.] FontB8x4[255] 72x68 24 

FontB8x8 FontB8x8[Ext.] FontB8x8[255] 72x136 48.5 

FontC1x1 FontC1x1[Ext.] FontC1x1[255] 9x24 8.5 

FontC1x2 FontC1x2[Ext.] FontC1x2[255] 9x48 17 

FontC2x1 FontC2x1[Ext.] FontC2x1[255] 18x24 8.5 

FontC2x2 FontC2x2[Ext.] FontC2x2[255] 18x48 17 

FontC2x4 FontC2x4[Ext.] FontC2x4[255] 18x96 34 

FontC4x2 FontC4x2[Ext.] FontC4x2[255] 36x48 17 

FontC4x4 FontC4x4[Ext.] FontC4x4[255] 36x96 34 

FontC4x8 FontC4x8[Ext.] FontC4x8[255] 36x192 68 

FontC8x4 FontC8x4[Ext.] FontC8x4[255] 72x96 34 

FontC8x8 FontC8x8[Ext.] FontC8x8[255] 72x192 68 

 



 

Ver. 1.00 - 21 - 

Windows Driver 
 

•Printer Fonts are defined as follows. 

 
1) FontA1x2 (Double height) 

- ANSI Character code support (Code Page 1252) 
- Font size (Dot): 12 x 48 
- Font size (Point): 17 

 
2) FontA1x2[Ext.] (Double height) 

- IBM expansion Character code support (Code Page 437)  
- Font size (Dot): 12 x 48 
- Font size (Point): 17 

 
3) FontA1x2[255] (Double height) 

- Buyer exclusive code support (User Code page)  
- Font size (Dot): 12 x 48 
- Font size (Point): 17 
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6-2 Special functions 

• This Windows driver supports the special functions as shown in the following table. 

Select FontControl font first and use the characters in the table to use the special functions.  
 

Note Take care as this function is not for printing general texts. 

 

Character Special Function 

5 Prints HT (0 x 09) 

6 Prints LF (0 x 0A) 

7 Prints CR (0 x 0D) 

i Prints the NV Image(FS p) saved in the 00 address (double-size) 

j Prints the NV Image(FS p) saved in the 01 address (double-size) 

k Prints the NV Image(FS p) saved in the 02 address (double-size) 

l Prints the NV Image(FS p) saved in the 03 address (double-size) 

m Prints the NV Image(FS p) saved in the 04 address (double-size) 

p Does not add HRI characters to the barcode 

q Adds HRI characters in Font A above the barcode 

r Adds HRI characters in Font A below the barcode 

s Adds HRI characters in Font B above the barcode 

t Adds HRI characters in Font B below the barcode 

u Turns white/black reverse printing mode on 

v Turns white/black reverse printing mode off 

w Aligns text to the left 

x Aligns text to the center 

y Aligns text to the right 

G Prints the NV bitmap(GS ( L) saved in the 00 address 

H Prints the NV bitmap(GS ( L) saved in the 01 address 

I Prints the NV bitmap(GS ( L) saved in the 02 address 

J Prints the NV bitmap(GS ( L) saved in the 03 address 

K Prints the NV bitmap(GS ( L) saved in the 04 address 

R Prints the NV Image(FS p) saved in the 00 address 

S Prints the NV Image(FS p) saved in the 01 address 

T Prints the NV Image(FS p) saved in the 02 address 

U Prints the NV Image(FS p) saved in the 03 address 

V Prints the NV Image(FS p) saved in the 04 address 

 
1) Example 
 
Select FontControl font and send 6 for “LF” (Line Feed) operation  
(instead of printing character “6”).  
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2) FontControl font functions. 
 

Font Name Special Functions 
Size (Point/Dot) 

203 dpi 

FontControl 

Alignment (Left/Center/Right), 
Output HT, Output LF, Output CR, 

Printing NV bitmap/Image 
8.5 / 12x24 

 
6-3 Barcodes 
 
Windows driver supports one-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. In addition, the 
FontControl font can be used to add HRI characters. 
 

Font Name Size Supported Characters 

Codabar 18 / 35.5 / 53 / 71 

Numeric : 0~9 

Symbols : $,+,-,.,/,: 

Letters : A~D 

Code39 18 / 35.5 / 53 / 71 

Numeric : 0~9 

Symbols : $,+,-,.,/,: 

Letters : A~D 

JAN13 (EAN) 18 / 35.5 / 53 / 71 Numeric : 0~9 

JAN8 (EAN) 18 / 35.5 / 53 / 71 Numeric : 0~9 

ITF 18 / 35.5 / 53 / 71 Numeric : 0~9 

UPC-A 18 / 35.5 / 53 / 71 Numeric : 0~9 

UPC-E 18 / 35.5 / 53 / 71 Numeric : 0~9 

Code93 18 / 35.5 / 53 / 71 ASCII CODE : 0x00~0x7F 

Code128 18 / 35.5 / 53 / 71 ASCII CODE : 0x00~0x7F 

 
1) Sample Use 
 
Select Code39 and Size 18, and then enter “1234”. The barcode corresponding to “1234” is 
printed. 
 
2) When Using Code128 
 
Select Code128 and Size 18, and then enter “{B1234”. The barcode corresponding to “1234” 
is printed. When using Code128, characters, such as “{A”, “{B”, “{C”, should be included 
before the input data. 
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6-4 Two-Dimensional Barcodes 
 
The Windows Driver supports the following two-dimensional barcodes. 
 

PDF417 GS1 Databar Omnidirect GS1 Databar UPC-E 
QR Code GS1 Databar Truncated GS1 Databar EAN-13 
DATAMATRIX Code GS1 Databar Stacked GS1 Databar EAN-8 
Aztec GS1 Databar Stacked Omnidirect GS1 Databar UCC/EAN-128&CC-A/B 
MAXI Code[Mode4] GS1 Databar Omnidirect  
GS1 Databar GS1 Databar UPC-A  

 
Usage is identical to that for barcodes. 
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7. Use of Windows Driver                                                
 
Sample codes are installed “C:\BIXOLON\Printer Driver\[Model name]\Sample”,  
when the driver install. 
 

Note 
If Windows was installed at “D” drive, the sample codes are installed “D” 
drive. 

 
7-1 Use of Visual Basic 
• This section contains example codes to control the printer using Windows driver with Visual  

Basic.  

 
 

7-1-1 Windows Driver Selection 
 
When you select the printer driver, please designate a device name by the printer name. 
The following example code explains how to select “BIXOLON SPP-R410” Windows driver. 
 

For Each prnPrinter In Printers 
 
If prnPrinter.DeviceName = “BIXOLON SPP-R410” Then 
 
Set Printer = prnPrinter 
 
Exit For 
 
End If 
 
Next 

 
7-1-2 Text Printing 

 
The following example code explains how to print texts using Windows fonts and printer fonts 
(device fonts). 
 

‘Print in Windows font 
Printer.FontSize = 9 
Printer.FontName = “Arial” 
Printer.Print “Arial Test”  
 
‘Print in printer font 
Printer.FontSize = 8.5 
Printer.FontName = “FontA1x1” 
Printer.Print “FontA1x1 Font”  
 
Printer.EndDoc 
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7-1-3 Barcode Printing  
 
The following example code explains how to print the barcode (JAN8 (EAN)). 
 

'Print Bar Code. 
Printer.FontSize = 18 
 
Printer.FontName = "JAN8 (EAN)" 
Printer.Print "1234567" 
 
Printer.EndDoc 

 
The following example code explains how to print the 2D barcode (PDF417). 
 

'Print Two-dimensional Codes. 
Printer.FontSize = 8.5 
 
Printer.FontName = "PDF417" 
Printer.Print "Print Test PDF417" 
 
Printer.EndDoc 
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7-2 Use of WordPad 
 
 

7-2-1 WordPad Environment Settings 
 
Launch WordPad, set the printing related options as follows, and test the printer with 
WordPad. 
 

- Select printer 
Select “Print” from the “File” menu, and select the BIXOLON printer. 

 
- Set paper size, orientation, margin, etc. 

Select the “Page Setting” from “File” menu, and set paper size, orientation, and margin. 
 
7-2-2 Text Printing 
 

 
 
1) Select the font from the font selection box (FontA1x1). 
 
2) Select the point size from the point selection box (8.5). 
 
3) Enter the text to print. 
 
4) Click the Print icon in the toolbar to print the text. 
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7-2-3 Barcode Printing 
 
Use the Windows Driver of the printer to print the barcode. 
 

 

 
1) Select the desired barcode from the Font menu (Code128). 
 
2) Select the desired font size (18). 
 
3) Enter “{A123456789012” in WordPad. 
 
4) Click the Print button in the toolbar to print. 
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7-2-4 Two-Dimensional Barcode Printing 
 
Use the Windows Driver of the printer to print the two-dimensional barcode. 
 

 

 
1) Select the desired two-dimensional barcode from the Font menu (PDF417). 
 
2) Select the desired font size (8.5). 
 
3) Enter “Two-dimensional Codes Test: PDF417” in WordPad. 
 
4) Click the Print button in the toolbar to print. 
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Copyright 
 
©  BIXOLON Co., Ltd. All rights reserved. 
   
This user manual and all property of the product are protected under copyright law. 
It is strictly prohibited to copy, store, and transmit the whole or any part of the manual and 
any property of the product without the prior written approval of BIXOLON Co., Ltd. 
The information contained herein is designed only for use with this BIXOLON product. 
BIXOLON is not responsible for any direct or indirect damages, arising from or related to use 
of this information. 
 
• The BIXOLON logo is the registered trademark of BIXOLON Co., Ltd. 
• All other brand or product names are trademarks of their respective companies or  

organizations. 
  
BIXOLON Co., Ltd. maintains ongoing efforts to enhance and upgrade the functions and  
quality of all our products. 
In the following, product specifications and/or user manual content may be changed without 
prior notice. 
 
 

Caution 
 
Some semiconductor devices are easily damaged by static electricity. You should turn the 
printer “OFF”, before you connect or remove the cables on the rear side, in order to guard the 
printer against the static electricity. If the printer is damaged by the static electricity, you 
should turn the printer “OFF”. 
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Rev. Date Page Description 

1.00 20.05.20 - New Manual format applied 
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